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1. Introduction

The iQlink software design focuses on data integrity, to facilitate superior network designs. iQlink is utilized by multiple
domestic and international customers in the designing of over 40,000 operating microwave links where integrity of the
data is of utmost importance.

To achieve this high level of data integrity, iQlink employs a highly relational Oracle database with many built-in integrity
checks, to ensure users avoid mistakes. For example, iQlink will not allow you to assign a 23 GHz antenna to a 7 GHz
microwave link design.

For this reason, the initial configuration setup of iQlink is centered on inputting all the equipment data that is required
for link designs. Once the initial setup is complete, designing reliable links is easy and efficient.

The intention of this document is to guide the user on how to launch the application successfully, perform the initial
setup of the equipment database and designing the network elements.

For additional aspects of iQlink, including details on the propagation models that are used, please refer to the iQlink
User Guide.

Need help with setup or anything else?

Contact us at iQlink-Support@comsearch.com. Comsearch is pleased to offer customized WebEx-based support
sessions with expert engineers for a low cost of $495 for up to 4 hours. Support services include, but not limited too:

- Initial setup of radios, antennas, frequency plans, sites and GIS data
- Getting started training

- Advanced training

Microwave design advice

Additional FREE support is also available 24x7 via our iQlink Support & Microwave Design Forum. Users will need to
register to access the online forum, which contains free tutorial videos in addition to a repository of GIS and
Equipment data available to download for free.

© 2020 Comsearch, A CommScope Company. Proprietary information. All Rights Reserved. Page | 3
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2. Outline

The steps below cover the outline of the initial steps from launching iQlink the first time, to designing your first
Microwave Link.

Create Band/Channels

Create or Import Radios

Calculate Interference Objectives

Create or Import Antennas

Create Waveguides/Attenuators (optional)

Create or Import Sites

Build your first Microwave Link
o Profile Analysis / Line of Sight check
o Link Budget (Design) check
o Interference Analysis
o Saving your link

e Creating reports

GIS database: minimum requirement to have Digital Terrain Elevation Map, DTEM file(s) to enable creating path
profiles. Morphology / Clutter database is also recommended. Using building database, vectors, and maps, satellite
images are optional. For detailed information on supported formats please visit the iQ:link Support & Microwave Design
Forum.

The iQlink installation package is shipped with demo databases of equipment: Radios, Antennas, Waveguides,
Attenuators, Frequency Plans and other related databases. Installation package also contains site data, pre-planned
microwave links and GIS data, which is intended for demonstration purposes only.

The demonstration database contains “dummy” data that can be used for trying out the features and
functions of iQlink. This demonstration data should not be used for real microwave link / network planning

purposes.

© 2020 Comsearch, A CommScope Company. Proprietary Information. All Rights Reserved. Page | 4
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3. Starting the application

Start the iQ’link application by clicking on the Windows start menu and selecting “iQ'link” under the list of programs:

2 iQlink - Login o X

Database Name: | xe

User Name: ]Iﬂ:
Password: ] .

Status: Connected.
Microwave Link Design.Software | e ype ey e

Use of iQ.link shall be in accordance with a signed Software License Agreement. In absence of a
signed Software License Agreement, use of iQ.link shall be deemed as acceptance of the End User
License Agreement, which can be found by dicking on the About button.

wininz

w m S bes _

Enter your User Name and Password and press the Enter key.

Default User Name:
Default Password:

link
pw

4. Installing the license

To install your license key, please follow the steps below

1.) Please launch iQlink
2.) Login

3.) Click OK to close the license warning message

4.) On the 'Login' window click on the 'About' button

5.) On the 'About' window click on the 'Enter License Key..." button
6.) On the 'License DB Interface' window select the line with the host ID shown on the 'About' window
7.) Click on the 'Edit' button

8.) Paste the license key above to the 'License String' field
9.) Click OK to close the 'Edit' window

10.) Click OK on the 'Update License Key' warning message
11.) Click Cancel to close the 'License DB Interface' window
12.) Click OK to close the 'About' window

13.) Click Quit to close iQ'link

14.) Launch iQlink and log in again (if previously appeared, the license warning in step 3.) above shouldn't appear,
indicating that iQlink did find a valid license for your system in the destination database)

© 2020 Comsearch, A CommScope Company. Proprietary information. All Rights Reserved.
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5. Populating the Equipment Database

The following sections introduce the main interfaces for the entry of equipment and spectrum data.

5.1. Bands and Channels

In Frequency Plans database you can Add, Edit, View or Delete channels of Frequency Band.

Database > Frequency Plans > Add

IMPORTANT: When you want to make link plans in a new frequency band you must define channels of new frequency
band first.

& Frequency Plan DB ? X

Frequency Plan DB - Mode: Add

Band: 80 GHz
Bandwidth: 500 MHz
Starting Channel#: CH 1

Starting Referenced:
Mumber of Channels: 10

Status: A

First Frequency Pair

Low: 71000 MHz High: | s1000] MHz

Win103

The above example will add the 80GHz band if it doesn’t exist, and 10 frequency pairs, separated by the bandwidth of
500 MHz, with channel numbers starting with CHO1 through CH20:

Channel Low Frequency High Frequency
CHO1 71000 81000
CHO2 71500 81500
CH10 75500 85500

© 2020 Comsearch, A CommScope Company. Proprietary Information. All Rights Reserved. Page | 6
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5.2. Radios

Radios can be entered manually into iQlink using the Radio Database Interface (Database > Radios) or imported using
the Radio Import Utility (Utilities > Radio Import).

NOTE: You may add new Radios into database only in the frequency band defined in the Frequency Plans database
described in section 5.1.

On how to import radios into iQ’link, please visit the iQ:link Support & Microwave Design Forum.

5.2.1.

Main Radio Details

Database

N

Add

o Radio Module ? X
General Information Technical Information
() Analog (@) Digital Band: GHz Stabiliy: %
o Saiiéctive 1 channel Bandwidth: MHz MTBE: 175200 Hrs.
Modet: | Min. Frequency: MHz Max. Frequency: MHz
Manufacturer:
Radio Type:
Radio Cade 1: Approval:
I WL r: Gov't Approval #:
e Capacity: Mbit/s Mask Class: |1 A
Thraughput: 154 Mbi Ennission Designator;
ACM Powrer Bagst Maxinum Boost: [ JdB roun e ission Designator
Min. Tx. Power: dBm Max, Tx, Power: dém
Apply same ATPC values for all modulation schemes (for ACM radios)
A, R Thr. (BER 107%): dBrm R Thr. (BER 10%): dBm
DS S Distartion RSL: dem MinmumRsL [ ] dem
Attenuator: Min. Signature BW: 30 MHz Non Min, Signature BW: 30 MHz
Power Limiter: Min. Signature Ht: 18 dB Non Min. Signature Ht: 18 dB
AL APLE Min Delay: 62 ns Non-Min Delay: 63 ns
RIPC Stepiaizeci|  0.00 ||dB Dispersive FM: 9.0 a8 XPIF: 15 ds
ACM Pwr. Adjust: |Highest Modulation hd Met Filter D.F: 15 | d8 FKTB: dBm
Apply same RTPC values for all modulation schemes (for ACM radios) ACM Drop Offset: 0.00 d&
‘Comments ACM Return Offset __0 00 | d8
ATPC Capable: Mote: Enter defalt AP porametrs o b ol f conigured o he highest
ATPC Margin 1 0.0 ¢8 ATPC Margin 2. d8
ATPC Receive Level 0.0 | dém
-
RTPC Att. Range: 0.00  dB RTPC Power Limiter Range: 0.00 d8
vio103
[ o - I o
5.2.2. Radio Configuration Options
Database > Radios > Options > Configuration ...
o Radio Configuration Options ? *
Configuration Options - Radio ID: 131 |
= . Tx Branching Loss  Rx Branching Loss Number of  MTBF
Configuration g Confia. Tyoe | —
anfiguratio 4B 4B onfig. Type Channels hours Statu —
Add

11+ AHSE [1.70
Pl 1+1 5 Hse 350
Ey 20 %pIC 0.00

1.70
3.50
0.00

Hot Standby |1

Hot Standby 1
MNane 2
Vi0.1.03

344300.00 | Active
34430000 Active
0.00 Active

© 2020 Comsearch, A CommScope Company. Proprietary information. All Rights Reserved.
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5.2.3. Radio Tx/Rx Curves

Database > Radios > Options > Tx Spectrum Mask Rx Selectivity > Single Calculation ...

& Radio: Tx Spectrum Mask & Rx Selectivity ? X

Tx Spectrum Mask

Model: | Model_38G14M | m

Modulation: | 256Q4M J

Freq. Band: | 38.00

Bandwidth: | 14.000000

Date: |2011-54

MHz Author: | Excel
50

T
-60 -40 -20

Rx Selectivity

Model: | Model_38G14M J m

Modulation: | 256QAM

dB 10

Freq. Band: | 38.00

Bandiwidth: | 14.000000

Date: | 2011-54

|60
= Pyl

T T
-60 -40 -20 0 20 40 &0

Vi0.1.03

Ili -ﬂllz: ¥ I‘-!t':: m

The Single Calculation option allows you to import curves, if the Tx and Rx data is provided by the manufacturer, it can
be imported from a text file using the Open button or press Edit to enter values manually. Alternatively use the
Calculate button at the bottom of the window to enter ETSI parameters for the system and fill up transmitted
spectrum and receiver filter curves. The Calculate button starts the Calculator, creates curves based on pre-populated
ETSI values. The Calculator creates Rx Selectivity curves based on various parameters including the Tx Spectrum Mask
limits. Typically, ETSI values are used here, but it is by no means limited to these.

NOTE: If ADM radio is selected, then table of used modulation types is appearing to select modulation type you want
to see.

Whilst the Batch Calculation creates curves based on pre-populated ETSI values, calculating Tx Spectrum Mask and Rx
Selectivity curves in batch mode automatically.

© 2020 Comsearch, A CommScope Company. Proprietary Information. All Rights Reserved. Page | 8
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5.2.4. IRF (Interference Reduction Factor) Curves

For accurate interference calculation results, after adding/importing a new radio, the Interference Reduction Factor
curves need to be calculated by iQlink. For that the IRF Objectives interface should be started...

Database > IRF Matrix

The band needs to be selected...

Options > Band > XX GHz

IRF matrix of selected band shows “X” marks if IRF data exists belonging to a pair of radio types. Radio ID is shown in
column and row headers (place mouse over Radio IDs in header to see Radio Model name.)

NOTE: If ADM radio is used, then Modulation ID also displayed (“/” sign used as separator)

By selecting an “X” and click on Edit data can be revised and overwritten or single calculation can be performed by
clicking Calculate button

Batch Calculation should be launched...

Options > Batch Calculation

During the Batch Calculation process, iQlink will check all Radio/Modulation combinations within the selected band,
and if finds a combination where no IRF curve is available, but Tx and Rx curves exist, it will calculate the IRF curve
automatically.

o IRF Mat O X

File Options Help

Selected Band: | 35.00 GHz

E & IRF Matrix Edit ? X

Freq. (MHz)  PsD (dB) |8 L MFL

40950000 -46,00 -104 L0
-39.900000 -46.00 =15 20 Modulation: | 4QAM

38850000 -46.00 L

-30
[0 Bandwidth (MHz): [7.000000
-37.800000  -46.00 R e P No. of Points: [ 381

-36750000  -46.00
e Tranan izt - Freq. (MHz) vs. PSD (dB)

Rox Selectivity
Freq. (MHz)  RF (dB) S L 2 MFL
42000000 -60.00

o re Model: [UX-38-7- 16QAM - 8x2
40950000 -60.00 oo Lao
39900000 -60.00 0] o Modulation: [ 16QAM
-38.850000 -60.00 60 L-60  Bandwidth (MHz): | 7.000000 |
37800000 -60.00 30 - .

60 40 -0 0 2 4 Mo. of Points: (A1

-36.750000 -60.00
= Freg. (MHz) vs. RF (dB)

2€ TnanAn znan

Interference Reduction Factor

Freq. (MHz) IRF (dB) 50 L L L L L 50 Fmin (MHz):

e 4486 40+ Lan Fma (MHz): ‘

Pl 19050000 4479 |
| M o000 4470 30 [30  Freq. Step (MHz): ‘

P 15750000 4430 204 f20 No. of Points: |25 ‘

Bl 12000000 4262 104 Lo |

(3 -12.250000 39.58 od Lo :

PAl 10500000 3592

EW -5.750000 3211 30 20 -0 0 10 20

&Y -7.000000 2824 = Freq. (MHz) vs. I8F (dB)

| vinLo3
Edit IRF Matrix for Radio Pair 120/3 - 53/6

NOTE: If you use the C/I Method for evaluating interference objectives, you may use the Radio Import Utility to convert
the IRF curves to C/I curves:

On how to convert IRF to C/I curves, please visit the iQlink Support & Microwave Design Forum.

© 2020 Comsearch, A CommScope Company. Proprietary information. All Rights Reserved. Page | 9
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5.3. Antennas

Antennas can be entered manually into iQlink using the Antenna Database Interface (Database > Update/Search >
Antennas) or imported using the Import Antenna Utility (Utilities > Import Antenna).

On how to use Import antenna utility, please visit the iQlink Support & Microwave Design Forum.

IMPORTANT: Please make sure to always have pattern data for all 4 polarization combinations (HH, HV VH, VV)

Database > Antennas

& View Antenna

Required Technical Info

Pattern Info

Manufacturer [Andrew

Model |VHLP2-7W

Style |Paraboloid

Gain (dBi)

Band (GHz)
Min.Freq. {MHz)
Max.Freq. {MHz)

3 dB BW (Degrees)
Diameter (m)

Length (m) :] Width

]

Pattern Date | 10 2| panvary  ~| | 2007 2|
Created |4 2| [May ~| 2011 2|
Last Update |4 2| [May ~| 2011 2|

Comments | iQ.link pattern number: 313

I

I

Reference () Gain (@) Discrimination

General Info

Status |ﬁ:t|ve

Parformance [High

Mounting [Both

LefLedle]

Approval Nurmber [

Gov't Apprv. Number |

Antenna Type [

Electrical Tilt O up
Q Factor (0-99 dg) [0.000 |
Type Approval

Comments

it
@ Down

l Revision Number: NSMA WG16.99.050

| Front to Back Ratio: 57.0

I Manufacturer Diagram Number: 70754

Angle  Gain  Discrimination

i 000 3070 0.00
Pl (.50 30,70 0.00
£l 1.00 3047 0.23
EN 1.50  30.00 070
L 200 2940 1.30
[ 250 2854 216
P 300 2745 325
[l 350 2633 4.37
El 400 2490 5.80
i)l 450 2318 T.52
BN 500 21.20 9.50
PN 5.50  19.01 11.69
ik 600 16.04 14.66
ARRN 127N 1800

Q, Pattern

VD103

In Pattern Info tab HH, HV, VH, VV patterns can be selected by clicking Polarization drop down box.

In this tab Elevational antenna patterns also can be entered or viewed by using Plane drop down box. If Elevational
antenna characteristics are not filled up, then iQlink will be using the default Azimuthal patterns instead of Elevational
by 3D antenna pattern calculations of Interference Analysis.

By using Pattern button selected antenna pattern can be viewed.

© 2020 Comsearch, A CommScope Company. Proprietary Information. All Rights Reserved.
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5.4. Waveguides

Database

)

Waveguides

5.5. Attenuators

& Waveguide Module ? X

Waveguide DB Module - Mode: Edit

Id: |2
Madel: | PER 220/UBR220/ #9425U%1103

Manufacturer: | RFS

Attenuation: | 120.00 dBf100m
Type:
Diameter: | 1.60 <m
Min. Length: Q.60 m
Max. Lenagth:  0.60 m

Database

)

Attenuators

@ Attenuator Module ? *

Attenuator DB Module - Mode: Edit

1D:

I

Model: | Fixed 10dB

Manufacturer:  Alcatel

Attenuation: | 10.00 dB

© 2020 Comsearch, A CommScope Company. Proprietary information. All Rights Reserved.
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6. Creating Network Elements

6.1. Sites

Sites can be entered manually into iQlink using the Site Database Interface (Database > Update/Search > Sites) or
imported using the Import Site Utility (Utilities > Import Site).

On how to import sites into iQlink, please visit the iQ:link Support & Microwave Design Forum.

IMPORTANT: Please make sure to have reference base of site coordinates on the same ellipsoid like the GIS data, for

accurate overlay.

Database

NEETD

Add, Change, Delete, View

& Site Database Interface - Change

site ID: | vso002

I Class:(®) Site () Site-In-Progress

Site Location Id:
Site Name: | \ienna 02
Gov't Approval #:

Gov't Appraval Status: () Approved [

) Unapproved (@) None

Latitude: | 48-12-37.500 N

Longitude: | 16-26-9.600 E

V| Latitude/Longitude

Aftemate

UTM Zone: | 33 |UTM
Morthing: | 5340684.5

Easting: | 606681.6

" i 1 P = 1
lemisphere: (@) Northern () Southerr

Grnd Elev: | 155.00
Structure Height: | 35.00
Mean Time to Repair: | 0.00

"

Hours

Display

PMP |

Owner:
Street{Ground Area:
Zip Code and City:

Country: |[Austria

Site Type:
Site Comment 1:
2:

Vi0.1.0.3

m

NOTE: Mandatory fields for a site are the ID, Name and a set of coordinates (labeled in bold). If you leave ground
elevation empty, or set it to O, the ground elevation will be automatically determined from the GIS data at the given

location.

© 2020 Comsearch, A CommScope Company. Proprietary Information. All Rights Reserved.
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6.2. Links

Links are Created in iQlink with the help of the Main Engineering Window...

Main Engineering > Files > Create Link

Here are the basic steps: Select/apply the end Sites, select the Band, choose the required radios and antennas
(optionally waveguides and attenuators).

NOTE: Channels don’t need to be pre-selected, when the link is created. Interference Analysis will help to select an
interference free channel at a later stage.

@ Main Engineering — X

oevoi-1 [ I

winiaz

Location ID: ~N
Site ID:  VS3568 Vvs0002
Name:  Schiittaustrabe 52 Vienna 02
Gov't Approval #:
Structure Heights 35.00 m 35.00 m
latlon:  48-13-33.3N 16-25-19.0 E 48-12-37.5N 16-26- 9.6 E )
UUTM Zone: N E: 33: 5342542.7 605603.1 33: 5340684.5 6066816 > Sites
Azimuth: 150,93 Deg 330.94Deg
Tilt:  0.22 Down 0.21Up
Length / TPL 2.15km J 130.92 dB
Band:  |38.00 GH - R Assi t: | Paired ired
an z Tequency Assignmen - p,
Radio Model_38G14M_21-90M Model_38G14M_21-90M A
Capadity/Modulation: 90,00 Mbys [ 256QAM* 141_A_HSB 90.00 Mb/s [ 256QAM 14+1_A_HSB
Power: | 15,00 6.60 dBm 15.00 5.60 dBm > Radios
Branching Loss: T 170 de Roc 1.70 de T 170 dB Roc 170 dé
Frequency Plan: m J
ID REF FREQ Pol T ID REF FREQ Pol T
C28 C28 37443 V P C28 C28 38703V P Channels
{0l Main ant, VHLP1-38 VHLP1-38
Gain: 40,11 dEi 40.11 d6i
Height:  35.00 mAGL 35.00 m AGL
Latilon:  48-13-38.3Nf16-25-19.0 48-12-37.5N/16-26- 2.6 € Ant
EIRP:  53.41 45.01dBm 53.41 45.01d8m ntennas
Diversity Ant.:
Gain: dBi dBi
Height:
of]] waveguide NIL NiL .
Total Length: Wavegmdes
 Totalloss:  dB d8
B NIL NiL
Common Tx Rx Loss: d& d8  dB 48 dE d8 Attenuators
Cther Losses: 0.00 dgé 0.00 dB

MO 1-1 Working

© 2020 Comsearch, A CommScope Company. Proprietary information. All Rights Reserved. Page | 13
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6.2.1. Profile Analysis

Main Engineering > Profile...

& Profile Plot — O *
Eile Tools View Help

1
Distance (km) vs. Height (m)
vin102
Schiittaustrafie 52 37443,000000 MHz Frequency: 38703.000000 MHz Vienna 02
Sites £53]
Site A Site B
Location ID:
Site ID: V53568 Vsoooz2
Site Name: Schilttaustrafe 52 Vienna 02
Coordinates: 48°1338.3"N  16°25'19.0"E 43°1237.5"N  16°26'9.6"E
Alternate Coordinates: 5342542,7 33: 605603.1 5340684.5 33: 000081.6
Azimuth: 150.93 Deg 330.94Deg
Ground Elevation: | 163.0 m Obstruction Loss 155.0 m
Tx - Tx Elevation Angle: -0.22 Deg Obstruction Loss = 0.00 dB at 50,0000 % 0.20 Deq
Tx - Dx Elevation Angle:
Dix - T Elevation Angle:
Sites Antenna Heights/Fresnel K Factor l Morphology and Building l Reflection l Obstruction Loss I

Create Working Link Apply n Cancel

In Profile Menu antenna heights can be optimized, terrain and morphology data revised or modified. Reflection and
Anti-Correlation analysis for Space Diversity system design can be performed.
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6.2.2.

Design (Outage/Unavailability Prediction)

Main Engineering > Design...
£+ Design m]
Link Id: DEMO1 Design Id: 1 Objectives:[ceneral  ~| Prediction Method:P.530-15/15  ~|
Site A Site B
Site 1d/Location Id: V53568 [ WS0002 /

Site Name:
Obstruction Loss:
Primary / Diversity [ ATPC RSL:

schirttaustraie 52 Vienna 02
0.00dB At 50.0000%

-39.10 [ NfA [ -43.50dBm

-39.10 [ NfA | -43.50dBm

>

ThresholdfACM Drop Level: 16°BER |16°BER -60.50dBm -60.50 dBm
Thr. Deg. A ( Field Margin / Thr, Deg. B: 0,00 dB Manual 1.00 dB 0,00
Composite Fade Margin: ZD.4DHEA ZD.4DdEA
Rain
~ | XPD
Rain Rate Method: _v| | ITU-R P.837-7 ]
Fi Di b
0,01% Rain Rate: | 28.8 ] mm/hr Combined Rain and Wet Snaw (UK) requency Bhversity
Raln < Combined Rain and Wet Snaw (P.530-18) Improvement Factors A->B B->A
Fi sity NIL Il
Polarity: il
~
H Geodimatic: 304 x 10°% Caloulator - L
Multi- ocimase ) K Objective: | 99.9950 %
Ri Default
h Rzin FFM Regd: 17,87 dB Pwr Reod: 12,47 dBm
pat
. Multipsth CFM Regd: 0,00 dB Pwr Read: -5,40 dBm
Avg A “C
~
Results
Unavailability: Outage: View All Modulations
Unavailability: Uptime(%) Downtime(%) Downtime(sec) Downtime(sec/km)
Rain 99.996820 0.003180 1002.86 466.64
Outage:
Flat Multipath 99.999935 0.000005 143 0.66
Selective 100.000000 0.000000 0.00 0.00
Total Qutage 99.999935 0.000005 1.43 0.66
Unavail. + Outage 99.995815 0.003185 1004.28 467.31
Generic ‘Woice Data
V10102
6.2.2.1  Propagation Models
e ITU-R P.530-6 through to ITU-R P.530-17
e Vigants
e Galuner

Link Budget

Diversity

Prediction
Results

The newest reliability model is the P.530-17 model. This does not require any user input while determining the
value of the geoclimatic factor. To find the proper geoclimatic factor for the earlier versions of the P.530 reliability
model, the geoclimatic Factor Calculator may be used. Setting the default value of the geoclimatic factor is possible

in the System Administration Utility

(Utilities > Sys Admin).

NOTE: For different versions of the P.530 recommendation series the value and definition of the geoclimatic

factor is also different.

6.2.2.2  Objective Models

For link performance calculation following Objective Models can be selected from drop down box:

e |TU-T G.826
e |TU-T G.821
e General

© 2020 Comsearch, A CommScope Company. Proprietary information. All Rights Reserved.

Page | 15



< comsearch. iQ-link Basics

A CommScope Company

Interference Analysis

Main Engineering > Interference

iQlink supports two Interference Calculation Methods, which need to be pre-selected in the System Administration
Utility.

The IRF method users interference reduction factor calculated by iQlink from the Tx Spectrum Mask / Rx Selectivity
curves of the radio, to normalize all interference to co-channel, then to determine the Threshold Degradation of the
victim based on the noise increase.

The C/I method compares the calculated T/l (when carrier faded to Threshold) against the objective provided by the
manufacturer of the victim radio, depending on the frequency separation. If the calculated T/l is missing the objective

provided by the manufacturer, the case is reported.

It is recommended to use the method which is also used by the regulator of the country the link is designed in.

6.2.2.3  IRF Method

6.2.2.3.1 Analysis Parameters

Set and select the appropriate parameters for the interference analysis.

NOTE: Please pay attention to all the calculation parameters, in particular the Search Radius (Coordination distance),
as this has a dramatic affect on the results. For more information on this and the rest of the options below, please refer
to the iQlink Support & Microwave Design Forum for further details.

& 1A Culling Parameters - o X
General Filters Adaptive Modulation
Search Radius: [40.0 | km Count: 487 of 487 Links ’ Modulation Scheme: [ Highest [ Lowest [[Eng. Ref. | Lowest > Highest | Worst Case |
Link Fitter Options: [Analyze all links -] p—
esin parh poary: [+ | oot | I Bxclude Design Carriers: | Down Link | Up Link | Up Link i I
Assign Existing Polarity First?: o
———————————— Additional Analysis Options
Allow Polarity Change?: | Yes | Ho
Cumulative Analysis:
Channel Selection Curnulative OH Threshold: a8

Analyze Channels: [[Assigned Channels Only | Partial Band | Full Band |

Antenna Discrimination Mode: [ 2D | 3D |
Assign Existing Channels First?: | Yes | No
Use Correlated Criteria: | Yes Angle/LR/M: 5.00°/1.00/5.00 dB
Partial Band Filter (Site A/ Site B): Min: [C25/C25 | max: [c28/c28 |

Use XPIF:

Frequency Window: | 112 MHz(+/-)

o than 1 chamel s avalatle ten o | |y | e Exclude Design Path X-Pol Cases:
ost | Least | Degradition, or | First Channel in List |
assign a channel based on the:
IRF Method Parameters
single TO Margin: [0.20 | dB Cumulative TD Margin: [033 | dB
Default RF Value: | 0.00 dB Calculate IRF Curves on-the-fly Q
C/T Method Parameters
Margin: | 0.00 dB Default C/TObj.: | 37.00 dB
Cumulative Degradation Limit: dB
OH Loss.
Caleulate O Loss: [Yes | Mo | [5 - Maritime Temperate Over Land -]
Todude Buidng
Profle Start Distance: 0.0 | km Profile K Factor:
ATPC
Use ATPC Criteria:

Design Path Power: TXATPC
Environment Path Power TX ATPC

vin103
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6.2.2.3.2 Analysis Summary

With the Full Band option selected as Search Frequency on the window above, after completing the analysis, the
summary window below will list all channels available for the radio, with the number of interference cases into and
from each end.

To select an interference free channel, just choose a line where the Number of Cases is 0 for both ends and click
Assign Frequency.

& |nterference Analysis - ul X

Design Path Details

Site ID f Location ID: V53568 | V50002 [
Site Name: SchiittaustraBe 52 Vienna 02
Latitude Longitude: 48-13-38.3N 16-25-19.0E 48-12-37.5M 16-256-9.6E
UTM Zone: NE: 33: 5342542.7 605603.1 33: 5340684.5 606681.6
Gnd Elev & Length: 163.00 m 2,15km 155,00 m
Path Azimuth: 150.93° 330.94°
Radio Model: Model_38G14M_21-90M Model_38G14M_21-90M
Capadity /BW [ Mod.: S0 Mbjsec | 14 Mz fl2560aM =] s0Mbfsec 14MHz /
Power: 15,00 dBm 15.00 dBm
Channel [ Frequency: [NIL & fi =] (o & i K|
Antenna Model /Hgt.: VHLP1-38/35.00 mAGL VHLP1-38/35.00 mAGL

Antenna Coordinate: &E

Waveguide Loss:

Free Space / Abs. Loss: 130.69dB [ 0.23dB
RSL  Threshold: -39.17 dBm/-64.50 dBm -39.17 dBm/-64.50 dBm
Channel Summary
Channel Number Number Cumulative into Channel Number Number Cumulative into
Number ofCases ofPaths Site A (dBm) Number ofCases ofPaths Site B (dBm)
0 -148.75 0 0 -140.78
N CEENEE I | [ R
7 0 0 -141.67 &) C27 0 0 -136.69
4 o] 0 0 -139.30 0 0 -130.71
29 0 0 -160.03 0 0 -156.85
3 C30 0 0 -174.58 0 0 -163.19
7 =] 0 0 -164.73 0 0 -163.87
8 fee] 0 0 -147.11 0 0 -150.15
Frequency Assignment: Only Preferred Include OH Loss:
Channel Polarity: Horizontal Channel(s) Show Excluded Links:

vin102

6.2.2.3.2.1 Case Details

Further details of the interference cases are also available.

o Interference Case Details - a et

Environment Path Details

Site ID / Location ID: 53795/ 53812/ ;;E":\auwm o
Site Name: Muthg. 56-64 20, Brigittenauer Linde 224 3 1338321 [ 16 25 19.02F
Latitude Longitude: 48-14-53.0N 16-21-35.08 48-14-41.0N 16-22-12.08 33: 5342542.7 605603, 1
UTM Zone: North East: 33: 5344764.8 6009409 33: 5344407.9 601710.5 Disarimination Angle: 145.62°
Gnd Elev & Length: 178.00m 0.85km 158.00m
Path Azimuth: 115.90° 295.90° Site B
) Radio Model: UX - 38 - 7 - 4QAM - 4x2. UX - 38 - 7 - 40AM - 4x2 ;‘;r;';a}],zsj N/ 1626 9.60E
Capacity { B [Mod.: 4x2 Mbjsec | 7 MHz ifoam ] 4x2Mbjsec7MHz MM 1| 3353306845 6066816
Power: 15.00 dBm 15,00 dBm
Channel [ Fregency: 858 ~1/(38706.5H MHz -] Bse - 1/[374% 5 MHz -
Antenna Model fHgt.: SB1-380 (Gain: 0.00 dBi) / 25.00 mAGL SB1-380 (Gain: 0.00 dBi) / 56,50 mAGL
Antenna Coordinate: 5.06 48-14-4L0N 1 0E

344407.9 .5 S
Waveguide Loss: 0.00 dB 0.00 d8 D eee
Free Space [ Abs. Loss: 12262d8  /  0.09d8 S~
RSL / Threshold: -137.04 dBm /-79.00 dBm -137.04 dBm / -79.00 dBm ~~

alculation Results

Include OH Loss: Excude Environment Link In Future Analyses
Interference Radio Ofiloss Loss FSPL Intlevel S.TDCak S.TDObj C.TDCak C.TDOby B
Calculation Modulation (dB) Type (dB) (dBm) (dB) (dB) (dB) (dB)
Profle A->D | (320AM)->(4QAM) | 11556  ITU [13831 -270.93 0.00(CORR)  1.00 NfA 3.00 SiteC
D->A 20, Brigittenauer Lande 224
8oC 4314 41.00N [ 16 22 12.00E
33: 5344407.9 601710.5
C->B
Site D
Muthg. 5664
43 1453.00N / 16 21 35.00E
iz 33: 5344764,5 600940.9

Discrimination Angle: 0.60°

Design Channel A: C26/37415 B: C26/38675 Interfering Path 1 of 18 1886-1 Frimary

If the calculated Single or Cumulative Threshold Degradation exceeds the predefined objective, the case is reported
as an interference case.
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6.2.2.3.2.1.1  Cumulative Details

The Cumulative Details shows the list of links contributing to the cumulative threshold degradation.

& Cumulative Analysis Details ? X

Site A: SchiittaustrafBe 52 (L) Site B: Vienna 02 (H)

Link Id Interfering Link Channel [ Pol

Schittaustrale 52 (L) - Vienna 02 (H)
SchiittaustraBe 52 (L) - Vienna 02 (H) C28V - C28V

981 Gebhardgasse 8 (L) - BSC TGM Wexstr. (H) B34H - B34H
5088 22, Pirquetgasse (H) - BSC Skrabalg, Fernwarme (L) B34H - B34H
5258 Karneuburg Nord (L) - KW Karneuburg (H) BS54V - B54V
1147 Floridusg. 46 (L) - Wagramerstralie 21 (H) AGOH - AGSH
4919 MottebohmstraBe 4 (L) - BSC TGM Wesxstr, (H) B33V - B33V
1628 Wagramerstrafie 21 {H) - Siemensstr. (L) BS54V - B54V
511 MeierstraBe (H] - 3, HainburgerstraBe 33 (L) B33V - B33V
2437 21, Gerstlgasse 12 (H) - Kommunikationsplatz 1 (L) B34H - B34H
884 Schiittaustrafe 52 (L) - Mexicoplatz 24 (H) BSSH - BSSH
5430 3., Ungargasse 10 (L) - Denauturm (H) A105V - A105V
; EYEY) Cmmctlomte G0 TA AN Plamasbsimen (LY DEALL DEAL « s
Cumulative Summary
C/IObj (AMB):  36.34/35,33 dB C/ICalc (AfB):  35.66 [ 35.54 dB IntLevel (A/B): -100,16 /-100.04 dBm
FKTE (A/B): -94.97 / -84.97 dBm FKTE Margin A: 5.19 dB FKTE Margin B: 5.07 dB
Threshald(A/8): -64.50 / -64.50 dBm Degradation A: 1.15 dB Degradation B: 1.18 dB

vini02

Update D

6.2.2.4  ¢/I Method

6.2.2.4.1 Analysis Parameters

Set and select the appropriate parameters for the interference analysis.

NOTE: Please pay attention to all the calculation parameters, in particular the Search Radius (Coordination distance),
as this has a dramatic affect on the results. For more information on this and the rest of the options below, please refer
to the iQlink Support & Microwave Design Forum for further details.

@ |A Culling Parameters. - o X
General Filters Adaptive Modulation
Search Radus: o Count: 486 of 485 Links FIE IMﬂu'mn Scheme: [Highest Lowest [Eng. Ref. JLowest -> Highest [ worst Case | |
Link Filter Options: ‘N“!'VZ! alllinks ;l P
Design Path Polarity | Beth | I. asign Carriers |
Assign Exlsting Polarity First?: Yes | No |
Allow Polarity Change?: Yes | 1o | pedtenel -
Allow Polarity Change?: e ]
Cumulative Analysis:
“hannel Selection o . X
Analyze Channels; | Assigned Channels Only | Partial Band | Full Band
Mode:
Assion Exstng ChamnelFrs:_ves | o | sotenns Drininston Hode
" Angle/LR/M: 5.00°
Partial Band Filter (Site A /Site B): Min: [C25/C25 | Max: [c28/c2s | [Eal] Use Correlated Crtera: [Yes | ho | ALRAM: 5.00°/1.00/5.00 &8
Frequency Window: | 112 MHz{+/-) Use XPIF: m
If more than \(h‘nlmx\v ? |I‘\I\.II\‘\\|| st | Least |Dagradation, or Exdlude Design Path X-Pol Cases:
assian a channel based on the
IRF Method Parameters
Single TD Margin: |0.20 | dB Cumulative TD Margin: (0,34 | dB
Default IRF Value: |0,00 | dB Calculate IRF Curves on
€/ Method Parameters
Margin: | 0.00 dB Default C/TOby.: | 37.00 dB
Cumulative Degradation Limit: dB
OH Loss
Calculate OH Loss: |E - Maritime Temperate Over Land ;I
Include Building | Incude Morphology
Profile Start Distance: (0.0 | km Profle K Factor: (133 ~|
ATPC
Use ATPC Criteria: [ ¥
Design Path Power: TX ATPC
Enwvironment Path Power: TX ATPC
vinaaz
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6.2.2.4.2 Analysis Summary

With the Full Band option selected as Search Frequency on the window above, after completing the analysis, the
summary window below will list all channels available for the radio, with the number of interference cases into and

from each end.

To select an interference free channel, just choose a line where the Number of Cases is 0 for both ends and click

Assign Frequency.

& Interference Analysis

Site ID [ Location 1D:
Site Name:

Latitude Longitude:
UTM Zone: N E:

Gnd Elev & Length:
Path Azimuth:

Radio Model:
Capacity / BW [ Mod.:
Power:

Channel / Frequency:
Antenna Model / Hgt.:

Antenna Coordinate:

Wavequide Loss:
Free Space [ Abs. Loss:
RSL [ Threshaold:

— O *
Design Path Details
VS3568 VS0002 /
SchiittaustraBe 52 Vienna 02
48-13-38.3M 16-25-19.0E 48-12-37.5N 16-26-9.6E
33: 5342542.7 605603,1 33: 5340684.5 606681.6
163.00 m 2.15 km 155.00 m
150.932 330.94°
Model_38G14M_21-90M Madel_38G14M_21-90M
90 Mbfsec { 14 MHz fl2560AM  ~] 90Mbfsec, 14 MHz / [25608M ~1
15.00 dBm 15,00 dBm
[ra1L I AR ] [N ]/ [in ~]

VHLP1-38/35.00 mAGL
48-13-38.3N 16-25-19.0f
33: 5342542.7 &L 3.1
0.00 dB
130,69 dB / 0.23dB
-39.10 dBm/-64.50 dBm

Channel Summary

VHLP1-28/35.00 mAGL
48-12-37.5N 16-26-9.6E
33 5340684.5
0.00 dB

-39.10 dBm/-64.50 dBm

Channel Number Number Channel Number =
Number of Cases of Paths Number of Paths
€25 1.c25 2 1
c26 0 0
c27 1 1
a8 2 2
c29 0 0
c30 0 0
3 0 0 =
Frequency Assignment: | Paired | unpaired | Only Preferred Include OH Loss: | Yes | o |
Channel Polarity: | vertical | Horizontal | Channel(s) Show Excluded Links: o |
Vi10.1.0.3

Summary Re

You can choose between the Case Details and Cumulative Details by clicking on the appropriate button at the bottom

of this screen.
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6.2.2.4.2.1 Case Details

Further details of the interference cases are also available.

i0-link Basics

& Interference Case Details - [} X
Environment Path Details
’ . Site A
Site ID / Location ID: 53767/ $3572/ SchiittaustraBe 52
Site Name: Floridusg. 46 Wagramerstrafe 21 48133832 N/ 16 25 19.02 E
Latitude Longitude: 48-15-0.0M 16-24-43.0E 48-14-5.2N 16-25-17.3E 33: 5342542.7 605603.1
UTM Zone: North East: 33: 5345050.9 6048136 33: 5343373.4 605552.8
Gnd Elev & Length: 156.00 m 1.83 km 157.00 m .
Path Azimuth; 157.27° 337.28° \?'lte B 0
: UX-38-35-4QAM - 2x2 UX - 38 - 3.5 - 4QAM - 2x2 fenna
e B T —T P I ER BTSN/ 1626950
pacity { BW / Mod.: fsec [ 3.5 MHz /140 fsec/ 3.5 MHz /140 33: 5340684.5 606681.6
Power: 15.00 dBm 15.00 dBm Discrimination Angle: 6.97°
Channel / Fregency: [499 = | /[37402.75H MHz =] [ag9 =] /[38662.75H MHz =]
Antenna Model / Hgt.: SB1-380 (Gain: 39.60 dBi}) / 30.00 mAGL S5B1-380 (Gain: 39.60 dBi) / 58.00 mAGL
Antenna Coordinate: 48-15-0.0M 16-24-43.0F
33: 5345050.9 6048136
‘Waveguide Loss: 0.00 dB
Free Space /[ Abs. Loss: 129.31d6  / 0.20 dB
RSL [ Threshold: -55.31 dBm [ -82.00 dBm -55.31 dBm [ -82.00 dBm
Calculation Results
Include OH Loss: Exclude Envirenment Link In Future Analyses Prav.
Interference Radio OH Loss Loss FSPL Intlevel C/I Calc - Margin
Calculation  Modulation (dB) Type (dB) (dBm)  (dB)  'ntObi IntMode  “pp) o c
A->D Floridusg. 46
D-»A 48 150.00 N / 16 24 43.00 E
: 33: 5345050.9 604813.6
Profile B-=C  (2560AM)->(40AM) 000 ITU 13758 -7305 1275 (CORR) 170548 T/l  -4.31(CORR) Discrmination Angle: 0.62°
Profile C-=B [40AM)-=(2560AM) 000 ITU 13758 -93.05 28.55 36,34 dB T/ -7.79
Site D
4 » Wagramerstrafie 21
48 14 524N/ 16 25 17.33E
vioLo3 33: 5343373.4 605552.8
Design Channel A; C25/37401 B: C25/38661 Interfering Path 1 of 1 1147-1 Primary
NOTE: Negative Margin (dB) indicates possible interference.
6.2.2.4.2.2 Cumulative Details
To see additional details for a particular channel, highlight the channel and click on the Cum Details... button:
& Cumulative Analysis Details ? bed
Site A: SchilttaustraBe 52 (L) Site B: Vienna 02 (H)
- Free Space  C/ICalc OH Loss Loss Intlevel . . FreeSpace CjICalc OHLloss Loss IntLevel —
Link 1d Interfering Link Channel / Pol L.;zAF[:a) A | A T »'i{dl':‘m] XPIF A (dB) L;:“ o B(d8) | B(dB) | TypeB B Edém:‘ XPIF B (dB)
1 Floridusg. 46 (L) - Wagramerstrabe 21 (H) ASOH - ASOH 12245 10604  *  N/C -17054 13758 2855 000 ITU 8305
: B ERlinger Hauptstr. 82 (H) - Umspannwerk Aspern (L) ASBH - ASBH 14183 5048 ¢ N/C  -12388 13736 12436 N/C 18886
ER 2153 19.Pfarrplatz (H) - 19, HimmelstraBe 23 [Kirche) (L) ASTH-ASTH 13218 11658  *  N/C  -18109 14282 8042 1 NC -14482
PR 1005587 SchiittaustraBe 52 (L] - Steinbrechergasse 22 (H) C29W-C29V 12818 8335 000 U -147.85 13069 5731 NC -17081
s EEE Hauptstralie [H) - KW Greifenstein (L) ASOH - ASOH 14904 12846  * N/C  -19296 15077 8459 NC -149.09
A 2111 Karl SchaferstraBe 3 (L) - 21, Briinner Strafle 68-70 (H) ASTH-AQTH 13727 13356  *  N/C  -19806 14081 8533 N/C -14983
7 EEE SCS Vsendorf (L) - SCS-Bueracenter/Parkdeck [H) ASTH-ASTH 14783 8564  * N/ -150.14 14714 14247 NC | -20697
(Rl 2168 ERlinggasse 16 (L) - Zentrum FW. Raiffeisen Platz (H) AGBH - AQBH 13537 12027 ¢+ N/ -19377 13785 8573 NWC -15023
o [EELTS 21,Leiner Langenzersdorf (L) - 21, RussbergstraBe 13/13 (H) ASOH-ASSH 14160 13191 ¢ N/C -19641 14488 8306  *  N/C 15356
10 ELN Fischamend Reichsstraie (H) - Flughafen Wien, Sofitel (L) ASTH-ASTH 14892 9040 *  N/C  -i5460 14676 12702 N -19182
1 e Dampfmiihigasse 3 (H) - Laaerberg (L] A9OH-AS9H 13826 9032 ¢ N/C 15482
12 Dablinger Hauptstrasse 1 (L} - BSC TGM Wexstr, (H) B49H -B49H 13612 12305  *  N/C  -187.55 14048 9069 NC -155.9 _
Cumulative Summary
/1 Obj (A/B): 36.34 / 36.34 dB f1 Cale (A/B): 59.43 / 26.55 dB Int Level (A/B): -123.83 / -93.05 dBm
FKTB (A/B): -34.97 ( -94.97 dBm FKTB Margin A: 26.96 dB FKTE Margin B: -1.92 dB
Threshald{A/B): -64.50 / -64.50 dBm Degradation A: 0.01 dB Degradation B: 4.07 dB
V10.1.0.3

The above window shows each link that contributes to the total interference into the design link.
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7. Network Visualization

7.1. Network View

Utilities > Network View

This is the graphical network display window. For a further detailed description, please refer to the iQlink Support &
Microwave Design Forum.

& Metwork View - ] b4
File Edit View Search

2L AR 0N 219218 AROC)

Vi1l.1.0.3

—— 1km Latitude: 48 16 18.47 M Longitude: 16 23 32.13E Elevation: 165.00 m (®) Band (| Capacity

Legend ()
uency (GHz Capacity (Mb/s / Channels Terrain Maorphology Site bol =

'3 7.00 ] 4.00 * Unclassified & Ease Station

* 15.00 * 8.00 * 0 Open i BB Netvrork

23.00 * 11,00 @ 125 ® Bridge 'y ES

* 26,00 * 14,00 * 187 * Water Features Fay BS with Fiber

* 28.00 ® 16.00 @ 250 * Light Vegetaticn C] Controller |

5 3800 . 21.00 ® 312 L ] Snarsa Venstatinn ] Customer X
Legend Palygan | Point to Multipoint |
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Below is a brief description of each button:

"2

Link Info

Copy Link

Site Info
/Create Site

Copy Site

Detailed
Profile

Line-of-Sight
Analysis

Overlap
Analysis

Clusters

Chain
Reliability

Automatic

Frequency Planning

Zoom In

Zoom Out

Re-Center

Pan

Refresh

Click this button, then click on a link to see basic link details.

Click this button, then click on a link, then use File > Paste Link in the Main
Engineering window, to work on an existing link.

Click this button, then click on a site to see basic details, or click on an empty
area to create a new site.

Click this button, then click on a site, then use File > Paste as Site A/B in the Main
Engineering window, to use a site in a link.

Click this button, then use your mouse to draw a line, and check the profile
between the end-points.

Click this button, then click on a point or a site to check LOS for the surrounding
region (Radial mode) or sites (Selective mode).

Used to check line-of-sight from two sites. Repeater sites can be placed to the
locations where both sites have line-of-sight.

Used to create/manage groups of links for display purposes

Used to check end-to-end reliability between a set of links.

Batch Interference Calculations (see more details in the User’s Manual).

Increase magnification.

Decrease magnification.

Reset main focal point.

Hold and drag to move freely.

Update page results.
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8. Reporting and Exporting Data

8.1. Engineering Record / Export

You may export all or portions of your link data, including the reliability calculations to a text file or to a formatted HTML
report using the Engineering Record report:

Database >

Engineering Record / Export

& Engineering Record/Export

Site ID:
Site MName:

Link ID:

Query on

Location 1D:

Band:

GHz

Design ID Status Site ID

Site ID Site Name

VI WWeXsIr.

5486
DEMO1
5390025538

w
B
4
L=
RSP A S S A U A ey

Default

53653/
53652/
53004/
53762/
§3750/
54053/
53072/
VS3568/
W 53900/

S T OO DT O 9O

1180 Le|
1230 W
Perlasgg
Zentag.
Schlogly
Te,p Sto
Wiener
Schittal

Heiliger

NOTE: Further report templates can be created by using a HTML editor.

& Document View

o comsearch

Link ID: DEMOC1
Link Mame:

Freguency Band: 38.00 GHz
Report: 1 of 1
Report Date: 19-Mar-2020

waTnze

iQ-linke — Microwave Engineering Record

Status: W-Werking

Address: N/A

Phone: Mi&
Fax: NIA
E-mail: N/A

Create Date: 06-May-2011 Created By: Henrik
Site ID / Location ID V33568 / V50002 1
Site Name Schittaustralie 52 Vienna 02
Street Name Schittaustraie 52
City Mame 1220 Wien
Site Crwner
Coordinates (Lat,Lon) 48-13-38.3N, 16-25-19.0E 48-12-37.5M, 16-26-9.6E
Coordinates 33:5342542.7 6056031 33:5340684.5.606681.6
({region:Northing, Easting)
Ground Elevation (m} 163.000000 155.000000
Radio Model Model_38G14M_21-90M Model_38G14M_21-90M
Qutput Power (dBm) / Reference 15.00 7 256QAMYY 15.00 ( 2560AMH
Madulation
Spectrum Mask Class - LowReference |4 86 466
High
Channel Spacing (MHz) 14000000 14.000000
Capacity (Mbit's) a0 0
Radio Manufacturer MF4 MF4
Frequency Plan: Frequency (MHz)  |Low: 37443.000000 High: 38703.000000
Polarization A v
ATPC TX Power (dBm) |RX Level (dBm) |TX Power (dBm) |RX Level (dBm}
Maximum 15.00 -38.11 15.00 -39.11
Maximum Trigger 4.44 -48.50 4.44 -48.50
Minimum Trigger 4.44 -48.50 4.44 -48.50
ATPC Modulation { Range (dB) 256QAM /10,56 256QAM [ 10.56

VINLO3

Cancel
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8.2. Google Earth Export

You may export your entire network stored in iQlink into a KMZ file which can be opened in Google Earth.

For more details on the Google Earth Export Utility, please visit the iQlink Support & Microwave Design Forum.

Google Earth Export

Utilities >

Warling Frimary Confirmed
() AllSites () Only Sites associated with links
Auto Coordinate Transform

KMZ file |_C:".Use|'5'\ic|IinILnetwurIc.Icmz

Idle

| £ Google Earth Export - V9.7.0.1 — s
Legin
Host/IP
Fort [] Use Oracle Client 10CH)
SIk
User Name
Passward
[ ] Link 1D filter [] Location 1D filter
D Batinding Box Latitude Langitude
Upper Right Corner  north east
Lower Left Corner  south west

Man Microwave

() site filter |

| | Browse... |

|
| | Launeh GE | Gaogle Earth It) |
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9. Google Earth Connectivity

Google Earth Connectivity tool provides a detailed network overview using Google Earth application.

Windows Start Menu > iQlink > Google Earth NetView

To use Google Earth Connectivity, you must have Google Earth installed.

iQlink (see: earth.google.com) Google Earth Connectivity overlays Site, Microwave Link and Non-Microwave Link
database of iQlink, as well as makes toggle on/off Map Layer defined under iQlink. Function can be found in Google
Earth’s Places window, under Temporary Places/ iQlink folder.

For further detailed information on Google Earth Connectivity, please visit the iQlink Support & Microwave Design
Forum.

IMPORTANT: Google Earth Connectivity tool makes no data available on internet!

Site, Microwave, Non-Microwave Link data and Map data will be NOT shared on internet through Google Earth
application; all overlaying data are stored on your local computer only.

= Google Earth Pro = (=) X
File Edit View Tools Add Help

¥ Search ‘ m HZ'[.J” a
\ [

"H < (@ 0] Ifc:\u]mlm\ .

Get Directions History
¥ Places

v (@€ i0linkxG
v/ o# Google Earth Net!
[¥/ gy Create Site
» O [F WMS overlays

v m. Layers

b |¥|Site Layer

b [v|LIP layer

b [¥] LINK layer

b [¥] Non-MW layer
v B Temporary Places -
Bal (+[+]z]
¥ Lavers l V.
v B2 Primary Database &

- /B Announcements

» [¥| ¥ Borders and Labels

& Places

» L = Photos
[¥/== Roads
| 3D Buildings
» [VI€8 Ocean ‘ > 5 | \
b [ ‘a Weather 5 | : i A ¥ 3013!37.82" N 924!30.98" V. leyelalty 2.42 km
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9.1. Sites

By clicking on a site, the basic Info window appears with tabs of Site, Antennas, Radios and Channels tabs:

height AGL = 56 m -

Channels

Site Class: Site (KPN-B-Station-Fiber)
Site Location ID:

Latitude: 4322944 Longitude: 15.35773
Northing: 5342745 48 Easting: 503302.79
UTM Zone: 22U Hemisphere: Northern

Ground Elevation (stored with the site}: 0 m [(AMSL Above Mean Sea Level)
Structure Height 55 m (AGL Above Ground Level}
Crarner:

TtraatiFrramd Braa- Friedrich_Hilleneist_ Shr 1
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9.2. Microwave Links and Non-Microwave Links

By clicking on a Microwave (or Non-Microwave) Link basic Link Info window appears:

Link ID &F g40-1

Location ID:|
Name:|

Latitude/Longitude:
Northing/ Easting:|

UTM Zone:|

Ground Elevation:
AntennalPath Azimuth:|
Mech./Elec./Path Tilt:

Sites / Sector ID

Status W Lip (P)

Path Profile

Path Length = 1.142 km Band

= 53607

s 53583

Praterstern 3-4

48°13'13°N, 016°2327E
5341718.77 603306.35
33U

158 m

26.85 Deg

1.05 Up

BSC Friedrich-Hillegeist-
tr.1

48°13'46°N, 016°23'52'E
534774696 603303.61

33U

157 m

206.85 Deg

1.057 Down

Frequencies

Plan:
ChanneliFrequency Pol.:|

High
BS4 38682 500 H

Low
BS54 37432500 H

Radios

Make:

Model:

Bit Rate:|
Bandwidth:,
Power:|
Branching Loss:|

MF1
UX-28-7-16QAM-Bx2
8x2

7.00 MHz

16.00 dBm

Tx: .00 dB | Rx: .00 dB

MF1
UX-38-7-16QAM-8x2
Bx2

7.00 MHz

16.00 dBm

Tx: .00 dB | Rx: .00 dB

Antennas (Primary)

Make:

Model:|

Gain:|

Height:|
Latitude/Longitude:|
EIRP:

MF1

S5B1-360

39.60 dBi

30

48'1313'N, (16°23'27°E
33.60 dBm

MF1

5B1-380

38.60 dBi

53

48°13'46"N, 016°23'52'E
33.60 dBm

Field Margin:
Absorption Loss:

Free Space Loss:|

Total Propagation Loss:

Receive Signal Level:
Last Modified

-52.13 dBm
Confirmed date:

1.00 dB

0.13 dB

125.2 dB

12533 dB
-52.13 dBm

Click on Path Profile button to see profile of selected link. Profile data are obtained online, 100% of 1 Fresnel-zone
and Line-of-Sight between sites are displayed. Actual height data on profile and marker on overlay map will be show
when cursor moves along profile.

—Ce————

. M Google Bewvation (m) B Fresnel Zonel top [l Line-of-sight B Fresnel Zonel bottom

1. 41km

Line-of-zight: 234.78

¥
&
£
c 20
8
2
&

1m

it

4
P Y T B L O L T g L T e

Tota! Path Lengih: 2.350 b (Curment femain msokidion: 7833 )

[Gite 1D A: 53512

Link ID: 1227-1

Site ID B: 53573

Site Hame A: Schi

gasse 25

Site Hame B: Donau Citystrake

Height: 25.284 m

Ant: Height: 113.32 m

LatLon: 46*15"15"H, 016°23"48"E

LatLon: 46*14°09"H, 016°24'43"E

Google AMSL Ant. Height: 191 m

Google AMSL Ant. Height: 284 m

Google Ant. Tilt: 2.25 Up

Path Length: 2.350 km

Google Ant. Tilt: 2.266 Down
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9.3. Legends and Statistics

When Site, Microwave or Non-Microwave Link Layer subfolder are clicked in iQlink folder a window appears with Site
Symbol, Link Frequency Band, Link Capacity Legends and Statistics

Site Legend

Site Symbol Name fites SIPs

1
E A EPP-IE_we_tower 3
7 KPM-B-Statian-Fiber 4
g ‘. KPH-B-Station 1
14 . Cffshare_platform 1
15 [ ] Custorner 5
16 (]} Ewent-BCS 2
17 @ Ewent-Mabile 4

MOTE: This list of swrbols is fullw custarmizable, so the swmbal and the narme can be modified easily, Contact your Product Suppart
Engineer For assistance, e-mail: customersupport@comsearch.com

Link Band Legend

Band | Confirmed LINK/Primary LIP LineStyle Working LIP LineStyle Confirmed | Primary | Working
1}

7 GHz Lo LG i} ]
iE GHz 15.GH 15.GH 0 0 0
23 GHz 1] 1 1]
26 GHz 26 .GH 28.5H ] ] ]
28 GHz 28.GH 0 0 0
38 GHz 1} g 1
#0 GHz ey G0.GH i i i

MNOTE: 2ddinag a new Eand to the Database is awailable via Freowency Aan Mook To add frequency plans to the database, click on the
Add button of the Freguency San Management Spstem Winabw |

Link Capacity Legend

4 ks 4 Ilbe - 4Mbps i 1 0
Shbps | —dldbgE —_  Obbbe i 7 i
16 Mbps | —lEbBEE — T 0 1 n
21 Mbps ———"— 0 0 1

ambps | alles — ey 0 0 L
52 Mbps | =Ll —— 0 0 L
86 Mbps | Lol E——— ¢ € !
76 Mbps ————— 0 o !
90 Mbps ———— 0 0 !

MOTE:The bitrate database is used to claszifw microwawe link bitrates based on the capacity of the radio used and the number of channels
assianed to each microwave link, The infarrmation stored through this interface is used by Network: Yiew to determnine the total bitrate of
each microwave link.,

To add a bitrate ta the database, click the Add Button on the & £ate Management Spatem Window -
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10. Projects

& iQulink - Login - X

Database Name: | xE

User Name: | ik
l’asmtd:]n

Status: Connected.
Project: Austria_Demo_Only

Microwave Link Design.Software |

Use of iQ.link shall be in accordance with a signed Software License Agreement. In absence of a
signed Software Licanse Agreement, use of iQ.link shall be deemed as acceptance of the End User

License Agreement, which can be found by clicking on the About button,

vininz

Projects button can be found on the Login window. You may define projects located in different countries and set up
GIS database as necessary for each project individually.

Click on Create, to set up a new project. Select Country from the drop-down list, and use the Details buttons to define
location of Terrain, Morphology (clutter), Building, Vectors and 2D Map GIS data you would like to configure for your

project:

£ Create Project - [m]

*
Project Information Path Spedfication ——
Use Relative Paths
Project Name: [| ]
Country: [Select Country <] || @ vse posoltepats
GIS File Selection
Terrain: No Fles Selected Er
Morphology: No Fies Selected Er
Buiding: No Fies Selected [ O Detais |
Vector: No Fies Selected [ O Detais |
Map: Mo Fies Selected [ O Detais |

Elipsoid Parameters

iquatorial Rads (m] Polar Radius (m)

Scaling Factor

iQ.GIS Location: C:/iQlinkXG/mids/bin

Alternate Coordinate System: J
Bounding Box
V| Automatically Calculate Latitude Longitude
Upper Right Corner Morth East
Lower Left Corner: South West
V0102
p— [ oo J oo

Saved Projects can be activated by clicking Make Current button.
to the iQlink Support & Microwave Design Forum.

For more details on the Project feature, please refer
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11. Database Maintenance Operations

A basic set of database utilities are available in Windows Start Menu / iQlink / DB Admin subfolder for maintaining the
Oracle database used by iQlink. Further information is available on the iQlink Support & Microwave Design Forum.

11.1. Database Backup

B i

DB Free Space Check
Documentation

GIS data by ComputaMaps
Google Earth NetView
iQlinkXG

Obtaining your Free License Key
Oracle Start

Oracle Stop

Uninstall

XG DB Backup

XG DB Check

XG DB Purge

HDHOHeo D

XG DB Restore

Database backup utility can be used for backing up your database, storing all equipment, site and link details in the
backup file. GIS database will be NOT saved.

Windows Start Menu >

iQlink

> DB Admin

)

XG DB Backup

By starting XG DB Backup application a CMD window appears. Here hit “y” to start creating backup file. Backup file

location is fixed, can not be changed.

[ XG DB Backup

kup T

iqlink
iqlink
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11.2. Database Restore

Database restore utility can be used to restore your database from previously backed up files. Restore utility loads into
database saved dump file of all equipment, as well as site and link data.

Windows Start Menu > iQlink > DB Admin > XG DB Restore

“. n “

By starting XG DB Restore application a CMD window appears, hit “n” for select next file and hit “y” to start process
restoring from selected file. Restore file location is fixed, can not be changed.

& XG DB Restore = a X

Would you like import the iQ.linkXG database from the backup file below ?

[demo_v9315_AUT700.dmp.bz2

Your choice [y/n/q]?: o

11.3. Database Purge

Database Purge utility can be used for cleaning your database from unnecessary data. Main purpose of this utility to
remove the DEMO objects shipped with iQlink installation package.

IMPORTANT: By using XG DB Purge utility all records of the selected object types will be deleted, selecting a subset of
objects is NOT possible.

Windows Start Menu > iQlink > DB Admin > XG DB Purge

By starting XG DB Purge application a CMD window appears, hit “1” to remove all link and site data OR hit “2” to
remove link, site, all equipment and frequency channel data.

[3) XG DB Purge - m] X

iQ.1inkXG Comman

iQ.1linkXG DB.
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12. iQlink System Administration Utility

Utilities >

System Admin

The System Administration Utility is to control iQlink application settings and certain defaults.

Rights of setting defaults are divided to Super Administrator and Regional Administrator parts. Both for Super
Administrator and Regional Administrator default password is: iglink

File Category Help

System Admin. Utility Login

@ System Admin. Utility - Super Ad... — O

(® Super Administrator
Login as:
(" Regional Administrator

Enter Password: eeseee

Status: o Logged In

Cancel

v10.1.0.5

When a Database Purge is performed it is important to set up new equipment defaults after new antennas and radios

were imported.

IMPORTANT: Parameter setting made in System Administration Utility can cause vital impact on link design. For details,
please visit the iQlink Support & Microwave Design Forum.
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